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Configuring HTTPS Messaging for Message Queuing (MSMQ) 3.0

Introduction

Message Queuing (MSMQ) 3.0 on computers running Microsoft® Windows® XP and Windows Server™ 2003 provides support for referencing URL-named queues, creating SOAP Reliable Messaging Protocol (SRMP) messages that can be sent over HTTP, and authenticating HTTPS messages. Messages can be sent over HTTP/HTTPS to destination queues on an intranet within an enterprise or over the Internet, and the sender and recipient can be in different forests or organizations. To send messages to a destination queue over HTTP, the target computer must have the Message Queuing HTTP Support component installed. Installing this component installs Internet Information Services (IIS) and creates an IIS extension for Message Queuing. Access to a Message Queuing queue can be restricted to specific users by changing the permissions of the Message Queuing virtual directory in IIS.

HTTP is automatically chosen as the transport for any Message Queuing message sent using an HTTP format name.
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Tip

The procedural information contained in this document relates to MSMQ 3.0 on computers running Windows Server 2003. There may be some discrepancies when using this document to configure HTTPS messaging for MSMQ 3.0 on computers running Windows XP.

HTTP Messaging

Destination queues for HTTP messages are opened using direct format names that include the URL address of the target computer, the virtual directory name, and the queue name separated by slashes. The default virtual directory name in IIS is msmq. In the following examples, the format names reference a queue that resides on a computer running MSMQ 3.0. The second example invokes a secure HTTP transport through a Secure Sockets Layer (SSL) connection. SSL uses certificates to allow clients and Web servers to authenticate each other, and encryption keys to establish a secure communication connection:

DIRECT=HTTP://MSMQComputer/msmq/MyPublicQueue

DIRECT=HTTPS://MSMQComputer/msmq/MyPublicQueue

Note the following:

· Format names used to send messages over the Internet must include the IP address or complete DNS name of the target computer, although the computer name is sufficient for sending messages within an enterprise. 

· The public, private, and direct format names of administration or response queues can be included in messages sent over HTTP. Conversely, the names of response queues in HTTP format can be included in messages sent over an ordinary (non-HTTP) transport. However, the use of distribution lists and multiple-element format names for this purpose is not supported.

When authentication is requested, Message Queuing automatically signs HTTP/HTTPS messages using an XML digital signature.

When sending an HTTPS message, the message format name should be in the same format as the server certificate name. For example:

· Server certificate = Servercertificate.domainname.com

– or –

· Server certificate = Servercertificate
Securing Messages with HTTPS

Using HTTPS to send messages ensures authentication of users requesting access to Message Queuing resources through a Web server, by establishing a Secure Sockets Layer (SSL) connection for secure communication between a sender and recipient. The Message Queuing service of the sender computer is always regarded as the SSL client, and the Message Queuing service of the recipient computer is regarded as the SSL server, regardless of how Message Queuing is configured on the computers.

The SSL security protocol provides data encryption, server authentication, message integrity, and optional client authentication for a TCP/IP connection. SSL allows the SSL client (the sender) to authenticate the SSL server (the receiver), and optionally allows the server to authenticate the client. SSL also negotiates an encryption algorithm before application data can be sent. SSL uses digital certificates for the purposes of authentication, and because SSL is built into all major browsers and Web servers, installing a digital certificate turns on their SSL capabilities.

When all the conditions are satisfied, an SSL connection involves the sender (SSL client) and recipient (SSL server) creating and exchanging SSL session keys that are used to encrypt all packets sent over the SSL connection. The SSL process can be summarized as follows:

1. A sender (SSL client) sends a message with an HTTPS format name.
2. The receiver (SSL server) acknowledges the client on the Web server’s TCP port (Default 443 for HTTPS), and responds with its server certificate to the client.
3. The sender (SSL client) checks that it trusts the Certificate Authority (CA) by checking that the CA that issued the certificate has a CA certificate in the sender’s Trusted Root Certification Authorities Store. The sender also checks that the certificate is valid and that the certificate details correspond to the SSL server.
4. Optionally the sender (SSL client) can authenticate itself to the server using a client certificate, if this is required by the server.
5. When all conditions are satisfied, the sender (SSL client) uses the public key contained in the server certificate to encrypt a random symmetric encryption key and sends it to the recipient with the encrypted message.
6. The receiver decrypts the symmetric encryption key using its private key and uses the symmetric key to decrypt the message. 
Certificates and Certification Authorities

Two kinds of certificates are used in SSL authentication:

· Server certificates. This certificate contains information about the server that allows a client to identify the server before sharing sensitive information.

· Client certificates. This certificate is optional, and contains information about the SSL client (the Message Queuing service of the sending computer) that identifies the client to the recipient.

A public-key certificate, usually just called a certificate, is a digitally-signed statement that binds the value of a public key to a person, a device, or a service that holds a corresponding private key. Most certificates are based on the X.509v3 certificate standard, and typically contain the following information:

· The subject’s (the entity that receives the certificate) public key value.

· The subject’s identifier information, such as name and e-mail address.

· A validity period for which the certificate is considered valid. Every certificate has a valid from and valid to date.

· Identifier information about the certificate authority that issued the certificate.

Certificates are generally issued by a Certificate Authority (CA), and can be issued to people, devices, or services running on a computer. Your organization might use the version of Certificate Services provided with the Windows Server 2003 family to run its own CA, or alternatively use certificates provided by a third-party CA. If you use the Microsoft Certificate Services, the Microsoft CA can be one of two types:

· Microsoft enterprise CA. Uses Active Directory® to verify the identification of the user, device, or service requesting the certificate. Certificates and Certificate Revocation Lists (CRLs) — published by a CA to keep an up-to-date list of revoked certificates — are published to Active Directory. This type of CA checks whether users, devices, or services requesting certificates have authorization to receive the type of certificate they are requesting. You can use the Certificate Request Wizard available in the Certificate Services MMC to request and manage this type of certificate.

· Microsoft stand-alone CA. Does not require Active Directory. This type of CA is less automated for a user than a Microsoft enterprise CA, because it does not have to use Active Directory. When submitting a certificate request to a stand-alone CA, the user making the request must explicitly supply all requested information. All requests for certificates are set to pending until approved by the administrator of the stand-alone CA. You cannot use the Certificate Request Wizard in Certificate Services to request or manage this type of certificate. Instead, use a Web page.

Managing CA root certificates

Every CA has a root certificate to confirm its own identity — either issued by another trusted CA or by itself. When a certificate is presented as a means of identifying the certificate holder, it is only useful if the entity receiving the certificate trusts the CA that issued the certificate. For Windows Server 2003 users, computers, and services, trust in a CA is established when there is a copy of the CA root certificate in the Trusted Root Certification Authorities Store on your computer, and a valid certification path to indicate that none of the certificates in the path has been revoked or has had its validity period expire. 

If you use a Microsoft enterprise CA, the root certificate is trusted by your computer automatically and you can skip the procedures that follow. Root certificates are also automatically included in the Trusted Root Certification Authorities Store for a number of third-party CAs.
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To verify that a third-party CA root certificate is in the Trusted Root Certification Authorities Store

7. Open Internet Explorer.

8. On the Tools menu, click Internet Options.

9. On the Content tab, click Certificates.

10. Click the Trusted Root Certification Authorities tab, and scroll down the list to check whether the CA is present.

Alternatively:

11. Open the Certificates MMC snap-in. For instructions, see Managing client certificates in the MMC snap-in.

12. Click to expand Trusted Root Certification Authorities.

13. Click Certificates, and check whether the CA appears in the console pane.

If your computer has a CA, but it is not in the Trusted Root Certification Authorities Store, do the following.
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To copy a third-party CA to the Trusted Root Certification Authorities Store

14. Open the Certificates MMC snap-in. For instructions, see Managing client certificates in the MMC snap-in.

15. Click to expand Intermediate Certification Authorities.

16. Click Certificates, and check whether the CA appears in the console pane. If it does, right-click the required CA, and then on the Action menu, click Copy.

17. In the console tree, click to expand Trusted Root Certification Authorities, and then click Certificates.

18. Click in the console pane, and on the Action menu, click Paste.

If the CA is not present on your computer, obtain a CA certificate.
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To download a third-party CA certificate from a CA Web page

19. Open Internet Explorer and navigate to the CA Web site. For certificates from Microsoft Certificate Server, connect to http://servername/certsvr, where servername is the name of the Web server where the CA you want to access is located.

20. Click Download a CA Certificate, certificate chain, or CRL.

21. Do one of the following:

a. If you want to trust all the certificates issued by this CA, click Install this CA certification chain.

b. If the CA has been renewed, you will have the choice of which version of the CA certificate you want to download:

i. Select the encoding method you want for the Certificate Revocation List (CRL): DER or Base 64.

ii. Under CA Certificate, click the CA certificate that you want to download, and then click Download CA Certificate, or click Download CA certificate chain.

iii. In File Download, click Open this file from its current location, and then click OK.

iv. When the Certificate dialog box appears, click Install this certificate.
v. In the Certificate Import Wizard, click Automatically select the certificate store based on the type of certificate. This places the CA certificate in your Trusted Root Certification Authorities Store.
22. If you are finished using the Certificate Services Web pages, close Internet Explorer.
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Note

Choosing Install this CA certification path is useful when you want to establish trust in a subordinate CA, but you do not currently have the certificate of the root CA of the certification hierarchy in your certificate store.

Server Certificates

Before an SSL connection can be established for sending messages, the recipient (SSL server) computer needs a server certificate that resides in the Certificates MMC snap-in on the local computer, in the Personal store under Certificates.

Internet Information Services (IIS) on the recipient computer sends the server certificate to the message sender (SSL client) for authentication. This server certificate contains the signature of the Certificate Authority (CA), the recipient’s public key, additional information about the recipient, and an expiry date. 

The server certificate must originate from a CA that the message sender trusts. When a sender computer trusts a CA, such as Verisign or Microsoft Certificate Services, it has a certificate from that CA (containing the signature and public key of the CA) in the Trusted Root Certification Authorities Store, under Certificate (Local Computer) in the Certificate snap-in. To authenticate the recipient computer, the sender verifies that it trusts the CA and validates the signature in the recipient’s server certificate.

Requesting a server certificate

When you request a certificate, you generate a key pair on your computer and your private key is installed for your access only. Your matching public key is also installed on your server as part of the digital certificate. The public and private keys are related but not identical. For message communication, a client sending a message to a server uses the public key contained in the server’s certificate to encrypt a session key, so that future communications are secure. Message content encrypted with the server’s public key can only be decrypted with the server’s private key.

Requests for a server certificate must be made by the user, computer, or service that has access to the private key associated with the public key that will be part of the certificate. There are two primary ways to explicitly request certificates in a Windows Server 2003 operating system. When you request certificates from a Windows Server 2003 enterprise CA, you can use the Certificate Request Wizard located in the Certificates snap-in. Note that only enterprise CAs available in your Windows domain can issue certificates using this wizard, and some features are not available using this wizard, such as marking keys as exportable or saving the request to a PKCS #10 file.

To select advanced features not available using the wizard, or to request certificates from a Windows Server 2003 stand-alone CA or from an external CA such as Verisign, each CA that is installed on a computer running Windows Server 2003 has Web pages that users can access to submit certificate requests. For Microsoft Certificate Server, these pages are located by default at http://servername/certsrv, where servername is the name of the computer running Windows Server 2003.

Before requesting a server certificate, make http://servername a trusted site for Internet Explorer.
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To make a CA site a trusted site for Internet Explorer

23. Open Internet Explorer.

24. On the Tools menu, click Internet Options.

25. On the Security tab, click Trusted Sites, and then click Sites.

26. Clear the Require server verification (https:) for all sites in the zone check box.

27. Type http://servername, and then click Add.

28. Click OK and close Internet Explorer.

After the CA site is a trusted Internet Explorer site, you can obtain a server certificate.
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To request a server certificate using a Web page

29. Open Internet Explorer.

30. Connect to http://servername/certsrv, where servername is the name of the Web server where the CA you want to access is located.
31. Click Request a certificate.

32. Click Create and submit a certificate request to this CA.

33. Click Advanced Certificate Request.
34. In Type of Certificate Needed, select Server Authentication Certificate, and then do the following:

c. Select Mark keys as exportable to save the public and private keys to a PKCS #12 file. This is useful if you change computers and want to move the keys.

d. Select Store certificate in the local computer certificate store to allow your computer access to the private key associated with the certificate when other users are logged on.

35. Click Submit.

36. Do one of the following:

e. If you see the Certificate Pending Web page, you need to carry out the procedure to check on a pending certificate, as follows:

i. On http://servername/certsrv, click View the status of a pending certificate request.

ii. If there are no pending certificate requests, you will see a message to that effect. Otherwise, select the certificate request you want to check, and then click Next.

iii. Check the pending certificate requests:

1. Still pending. You must wait for the administrator of the CA to issue the certificate. To remove the certificate request, click Remove.

2. Issued. To install the certificate, click Install this certificate.

3. Denied. Contact the CA administrator for more information.

f. If you see the Certificate Issued Web page, click Install this certificate.

37. If you are finished with the Certificate Services Web pages, close Internet Explorer.

38. The certificate is now available in your Personal certificate store.
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Notes

Remember that the sender (SSL client) computer must trust the CA that issued the server certificate to the receiver (SSL server). On the sender computer, check that there is a copy of the CA root certificate in the Trusted Root Certification Authorities Store. For more information, see Managing CA root certificates. This is not necessary if you are using a Microsoft enterprise CA.

The server certificate name specified should match the fully qualified domain name (FQDN) of the recipient (SSL server) to avoid name resolution issues between the CA server certificate and the SSL server.

In addition, the client certificate name specified in To request and install a client certificate using a Web page should match the FQDN name of the sender (SSL client) to avoid name resolution issues between the CA client certificate and the SSL client.

The SSL client and SSL server computers must be able to ping each other.

Installing a server certificate

After you have obtained a server certificate, you are ready to assign that certificate to a resource (install it). Before installing the certificate, ensure that you have IIS installed on your computer. 
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To check that IIS is installed on your computer
39. Click Start, right-click My Computer, and then click Manage.

40. In Computer Management, click to expand Services and Applications, and check if Internet Information Services appears.

If IIS is not installed, you can install it.
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To install IIS on your computer
41. Click Start, point to Control Panel, and then click Add or Remove Programs. 

42. In Add or Remove Programs, click Add/Remove Windows Components.

43. In the Windows Components Wizard, select Application Server, and then click Details. 

44. Select Internet Information Services (IIS) to install the default IIS components.
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Notes

IIS is installed automatically if you install the Message Queuing HTTP Support component. 

IIS provides the Web Server Certificate Wizard to manage server certificates. To assign a certificate to a Web resource (install a certificate), you must be a member of the Administrators group on the local computer, or you must have been delegated administrator permissions. For best security practice, log on to your computer using a nonadministrator account, and then use the RunAs command to run IIS as an administrator. To do this, from the command prompt, type runas /user:administrative_accountname “mmc %systemroot%\system32\inetsrv\iis.msc”.
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To install a server certificate using the Web Server Certificate Wizard

45. In IIS Manager, expand the local computer, and then expand the Web Sites folder.

46. Right-click the Web site or file that your want, and then click Properties.

47. On the Directory Security or File Security tab, under Secure Communications, click Server Certificate.

48. In the wizard, click Assign an existing certificate.

49. Select a certificate from your Personal certificate store.

50. Follow the wizard, which will guide you through the process of installing a server certificate.
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Note

The wizard always denotes this procedure as “assigning” a certificate to a resource (such as a site, file, or directory), and not as “installing.”

Client Certificates

An additional optional security component can be required for SSL sessions if IIS on the recipient also requests the sender’s client certificate for authentication. Client certificates, like server certificates, are obtained from a trusted Certificate Authority (CA) and are stored in the MSMQ\Personal store under Certificates - Service (Message Queuing) in the Certificates snap-in on the local computer.

Requesting a client certificate 

There are two primary ways to explicitly request client certificates in a Windows Server 2003 operating system. When you request certificates from a Windows Server 2003 enterprise CA, you can use the Certificate Request Wizard located in the Certificates snap-in. Note that only enterprise CAs available in your Windows domain can issue certificates using this wizard, and some features are not available using this wizard.

To set advanced features such as marking keys as exportable, or to request certificates from a Windows Server 2003 stand-alone CA or from an external CA such as Verisign, you cannot use the Certificate Request Wizard. As an alternative, each CA that is installed on a computer running Windows Server 2003 has a Web page that users can access to submit certificate requests. By default for Microsoft Certificate Server, these pages are located at http://servername/certsrv, where servername is the name of the computer running Windows Server 2003.
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To request and install a client certificate using a Web page

51. Open Internet Explorer, and navigate to the CA Web site. For certificates from Microsoft Certificate Server, connect to http://servername/certsvr, where servername is the name of the Web server running Windows Server 2003 where the CA that you want to access is located. Before requesting a client certificate, you might need to make the CA Web page a trusted site for Internet Explorer. For instructions, see To make a CA site a trusted site for Internet Explorer. 

52. Click Request a certificate.

53. Click Advanced Certificate Request.

54. Click Create and submit a certificate request to this CA.

55. Fill in any identifying information requested, including:

g. In Type of Certificate Needed, select Client Authentication Certificate.

h. Select Mark keys as exportable.

i. Select Store certificate in the local computer certificate store. 

56. Click Submit.

57. Do one of the following:

j. If you see the Certificate Pending Web page, you need to carry out the procedure to check on a pending certificate, as follows:

i. On http://servername/certsrv, click View the status of a pending certificate request.

ii. If there are no pending certificate requests, you will see a message to that effect. Otherwise, select the certificate request you want to check, and then click Next.

iii. Check the pending certificate requests:

1. Still pending. You must wait for the administrator of the CA to issue the certificate. To remove the certificate request, click Remove.

2. Issued. To install the certificate, click Install this certificate.

3. Denied. Contact the CA administrator for more information.

k. If you see the Certificate Issued Web page, click Install this certificate.

58. If you are finished with the Certificate Services Web pages, close Internet Explorer.

59. The certificate is now available in your Personal certificate store.

[image: image15.wmf]
Notes

Remember that the receiver (SSL server) must trust the CA that issued the client certificate to the sender (SSL client). On the receiver computer, check that there is a copy of the CA root certificate in the Trusted Root Certification Authorities Store. For more information, see Managing CA root certificates. This is not necessary if you are using a Microsoft enterprise CA.

The SSL client and SSL server computers must be able to ping each other.

After you have obtained the client certificate, verify that the certificate is in your Personal certificate store and is valid, and then move it to the Message Queuing service in the Certificates snap-in.
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To verify the validity of a client certificate

60. Open the Certificates MMC snap-in.

61. Locate the installed client certificate in the Personal store under Certificates (Local Computer). 

62. Double-click the certificate to verify it.

Managing client certificates in the MMC snap-in 

You manage client certificates using the Certificates custom MMC snap-in. There are two ways to open the snap-in, depending on whether the snap-in has been previously configured and saved.
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To open the Certificates MMC snap-in if you have not previously configured and saved a Certificates MMC snap-in

63. Click Start, click Run, type mmc, and then click OK.

64. On the File menu, click Add/Remove Snap-in, and then click Add.

65. Select Certificates, and then click Add.

66. Select Service Account, and then click Next.

67. Select Local Computer (the computer this console is running on), if it is not selected, and then click Next.

68. In Service Account, select Message Queuing, and then click Finish. When you finish working in the MMC console, you can save the settings so the custom MMC is available next time you open the console.

[image: image18.wmf]
To open the Certificates MMC snap-in if you have previously configured and saved a Certificates MMC snap-in

69. Click Start, click Run, type mmc, and then click OK.

70. On the File menu, click Open, and select the required Certificates MMC console.
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To move a client certificate to the Message Queuing service

71. Open the Certificates MMC snap-in. For instructions, see either To open the Certificates MMC snap-in if you have not previously configured and saved a Certificates MMC snap-in or To open the Certificates MMC snap-in if you have previously configured and saved a Certificates MMC snap-in.

72. Locate the installed client certificate in the Personal store under Certificates (Local Computer). 

73. Drag the certificate with your mouse to the MSMQ\Personal store under Certificates - Service (Message Queuing) on Local Computer in the Certificates snap-in. 

Exporting a client certificate

Client certificates must be exported for one-to-one mapping in IIS. Exporting a certificate copies it from its certificate store to a file that uses a standard certificate storage format.

To export a client certificate, do the following:
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To export a client certificate

74. Open the Certificates MMC snap-in. For instructions, see Managing client certificates in the MMC snap-in.

75. In the console tree, click Certificates.

76. Click to expand MSMQ\Personal.

77. Select and right-click the required certificate, select All Tasks, and then select Export.

78. In the Certificate Export Wizard, do the following:

l. Click Next, and then on the next page of the wizard, select No, do not include any private keys in the export, and then click Next.

m. Select Base64 Encoded X.509 (*.CER), and then click Next.

79. Follow the remaining steps to complete the wizard.
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Tip

You can also use this procedure to back up your certificate

After the certificate has been exported, you can proceed with IIS one-to-one mapping.

Mapping a client certificate

Even after a Web resource is configured to require an SSL connection, it still needs to be protected from unauthorized access. Because the anonymous user account has default write permissions for the physical MSMQ directory in IIS, this means that the default behavior is to ignore client authentication, and that any user can send HTTPS messages. To protect content after client certificates are enabled, you can create mappings that relate the information contained in a client certificate to a Windows user account. You can do one-to-one mapping to map individual client certificates to accounts, or many-to-one mapping to map a wide range of certificates that meet specific criteria against an account. In this way, you can restrict or allow access to the MSMQ virtual directory by configuring security settings for the corresponding physical directory. 

Before mapping the certificates, enable client certificate mapping.
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To enable client certificates and mapping

80. On the receiving computer, open the Internet Information Services (IIS) snap-in as follows: click Start, point to All Programs, point to Administrative Tools, and then click Internet Information Services (IIS) Manager. 

81. In the console tree, click to expand Web Sites, click to expand Default Web Site, right-click MSMQ, and then click Properties.

82. Select the Directory Security tab, and then under Secure Communications, click Edit. 

83. To require that a secure link be used for a site resource, click Require secure channel (SSL). 

84. Under Client Certificates, select one of the following to enable client certificate authentication: 

n. To enable clients to access a resource with a client certificate, click Accept client certificate. Note that a client certificate is not required. 

o. To ensure that users without a valid client certificate will be denied access to the site resource, click Require client certificate. 

p. To grant access to users with or without a client certificate, click Ignore client certificate. 

85. To enable client certificate mapping, in the Secure Communications dialog box, select Enable client certificate mapping if not already selected.

After client certificate mapping is enabled, you can map a specific client certificate to a user account (one-to-one mapping) as follows.

[image: image23.wmf]
To map a specific client certificate to a user account

86. Open the Internet Information Services (IIS) snap-in as follows: click Start, point to All Programs, point to Administrative Tools, and then click Internet Information Services (IIS) Manager.

87. In the console tree, click to expand Web Sites, click to expand Default Web Site, right-click MSMQ, and then click Properties.

88. Select the Directory Security tab, and then under Secure Communications, click Edit.

89. Select Enabled client certificate mapping if not selected, and then click Edit.

90. In the Account Mappings box, click the 1-to-1 tab.

91. Then, either add a new certificate by clicking Add, or edit an existing mapping by selecting the mapping and clicking Edit Map.

92. If you are adding a new certificate, browse to the certificate file and open it.

93. If you are configuring a mapping to an existing certificate, copy this client certificate locally, or place it into the share on the client computer.

94. In the Map to Account box, enter a name for the mapping. This is the name that will be displayed in the selection list in Account Mappings.

95. Either type or browse to a Windows user account. Type the password for the account that the certificate is mapped to, and then click OK.

96. Repeat these steps to map any other required certificates.
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Note

You must be a member of the Administrators group on the local computer to perform this procedure. 

For best security practice, log on to your computer using a nonadministrator account, and then use the Run As command to run IIS as an administrator. At the command prompt, type runas /user:administrative_accountname “mmc %systemroot%\system32\inetsrv\iis.msc”.

Map the certificate to the full user name. For example, domainname\username.

If you cannot find the certificate file, verify that you have exported it. For instructions, see To export a client certificate.

Configuring IIS Security Settings

After the certificate is mapped, you can specify security settings for the MSMQ virtual folder (msmq) in Internet Information Services (IIS). 

By default, IIS impersonates a special IIS local user account, IUSR_computername (also known as Internet Guest User Account) where computername is the name of the server on which IIS is running. This account is local to the IIS computer (unless it is a domain controller). It cannot be authenticated by other computers in the network, it is treated as an anonymous user, and it allows users to access Web resources without prompting for name and password information. This presents a problem for the following reasons:

· HTTP messages are authenticated using this anonymous account. If you want to limit a Web resource to HTTPS access only, you need to disable the anonymous access default.

· Active Server Page (ASP) applications and scripts run under IIS and by default impersonate the IIS local user for any Message Queuing operations, including queries to Active Directory. Because anonymous users no longer belong to the Everyone group in Windows Server 2003 operating systems, these queries fail. ASP applications and scripts cannot locate, create, and delete queues by default.
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To disable anonymous access in IIS

97. Click Start, click Run, type mmc, and then click OK. 

98. On the File menu, click Add/Remove Snap-in. 

99. In the Add/Remove Snap-in dialog box, click Add, select Internet Information Services, click Add, click Close, and then click OK. 

100. In the console tree, right-click MSMQ virtual directory. 

101. Click Properties, and then click the Directory Security tab. 

102. Under Authentication and access control, click Edit. 

103. To use a domain user account instead of the IIS local user for anonymous access, do the following: 

q. In the User Name edit box, type the name of a domain user with the required permissions for the Message Queuing operation. 

r. Type the user password, and then click OK. 

s. Retype the password in the Confirm Password dialog box, and then click OK. 

104. To disable anonymous access and trust the Internet Information Services computer for delegation, do the following: 

a. In the Enable Anonymous Access group, clear the Enable anonymous access check box, and click OK. 

b. Open Active Directory Users and Computers. 

c. On the View menu, click Users, Groups, and Computers as containers, and then click Advanced Features. 

d. In the console tree, right-click the name of your IIS computer. 

e. Click Properties. 

f. On the General page, select the Trust computer for delegation check box, and then click OK.

105. In the Internet Information Services snap-in, right-click YourInternet Information ServicesComputer. 

106. Restart IIS by selecting All Tasks \ Restart Internet Information Services, and then click OK.
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Notes

For the changes to take effect, you must stop and then start the World Wide Web Publishing service.

Trusting the computer for delegation allows multiple hops to communicate with a domain controller, assuming that the user account is trusted for delegation.

 You can then set up permissions on the MSMQ virtual folder.
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To modify permissions on the IIS MSMQ virtual folder

107. Open the IIS snap-in as follows: click Start, point to All Programs, point to Administrative Tools, and then click to expand Internet Information Services (IIS).

108. Click to expand Web Sites, and then click to expand Default Web Site.

109. Right-click MSMQ, and then click Permissions.

110. Remove all users except the mapped one.
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Note

Only perform this procedure when client certificate mapping is enabled.

Summary

To recap the activities required to configure HTTPS messaging for MSMQ 3.0 on computers running Windows XP and Windows Server 2003:

· The Message Queuing service on the sending computer sends a message in HTTPS format.

· Is the message in the correct format? See HTTP Messaging.

· An MSMQ computer receives a message in HTTPS format, and responds to the message sender with its server certificate.

· Does the receiving computer have MSMQ installed with the HTTP Support component to enable it to receive MSMQ messages over HTTP/HTTPS? See Introduction.

· Does the Message Queuing service on the receiving computer have a valid server certificate to send to the sending computer? See Requesting a server certificate.

· The sender computer receives the server certificate from the recipient computer, and checks that it trusts the CA that issued the server certificate. The sender also checks that the certificate details correspond to the MSMQ service on the receiving computer, and that the certificate is valid.

· Does the sender computer have a copy of a root certificate for the CA that issued the server certificate in its Trusted Root Certification Authorities Store? See Managing CA root certificates.

· The receiving computer (optionally) requires the sending computer to identify itself with a client certificate.

· Does the receiving computer have client certificates enabled? See To enable client certificates and mapping.

· Has the receiving computer set up specific permissions for the MSMQ directory in IIS by disabling anonymous access, and mapping client certificates to a specific user account that has permissions to access the MSMQ directory? See To enable client certificates and mapping.

· The sender computer sends its client certificate to the receiving computer.

· Does the sender computer have a valid client certificate from a trusted CA? See Requesting a client certificate.

· Does the receiving computer have a copy of a root certificate for the CA that issued the client certificate in its Trusted Root Certification Authorities Store? See Managing CA root certificates.

After all these conditions are satisfied, an SSL connection is established, in which the message sender and recipient create and exchange SSL session keys that are used to encrypt all packets sent over the SSL connection.

Troubleshooting

When troubleshooting HTTPS configuration issues, check the following:

· Does the CA issuing the certificate have a CA certificate in the Trusted Root Certificate Authorities Store? For more information, see Managing CA Root Certificates.

· Are DNS names being resolved? You can test for DNS name resolution by pinging the following:

· The SSL client computer and the SSL server computer.

· The SSL server computer and the server certificate CA.

· The SSL client computer and the client certificate CA.

· Is the client certificate valid and located in the correct folder? For more information, see To verify the validity of a Client Certificate.

· Is the server certificate valid and assigned to the correct Web site? For more information, see To install a server certificate using the Web Server Certificate Wizard.

· Are you sending messages in the right format? For more information, see HTTP Messaging.

· Have you exported the client certificate before configuring client mapping? Some client certificates require this. For more information, see Exporting a client certificate.

· Are you mapping a client certificate to a full user name, when mapping to an account? For instructions, see To map a specific client certificate to a user account.

· Do you have the appropriate administrator permissions to install IIS, and configure and map client certificates?

